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Introduction

Introduction
Thank you for purchasing a YSI IOEM and/or REM Expansion Module(s). The
IOEM-4, IOEM-8 and REM are networkable instruments that communicate with
YSI 5X00 family of programmable aquatic control and alarming instruments. (The
YSI 5X00 family of instruments include 5200A, 5400, 5500D-01, 5500D-02 and
5500D-04 instruments.) IOEM and REM expansion modules provide additional
inputs and outputs for 5X00 instruments existing on an RS485 network. Peripheral
devices wired and configured to IOEM and REM expansion modules add flexibility
and capability to a network. Configure IOEM and REM expansion modules as
needed for your application.
IOEM and REM instruments do not have a user interface, meaning no configuration can be done at the instrument. Use AquaManager® PC software program to
configure IOEM and REM instruments.
Please see IOEM/REM terminology - page 71 for terms used throughout this
manual in describing IOEM/REM nstrument features and functionality.

IOEM and REM features
IOEM and REM expansion modules share many common features. The common
features are listed below. (IOEM & REM unique features are provided following
the common features listed below.)
A 5X00 instrument is required and must be configured as the master on the
RS485 network;
•
NEMA-4X / IP65 enclosure;
•
universal AC power;
•
optional DC 12 VDC power, including battery backup;
•
*AquaManager® PC software is required and serves as a management
tool using either a direct (RS232) or TCP/IP connection where a 5X00
instrument is configured as a master on the RS485 network;
•
1 32-bit processor;
•
networking capability - With a 5X00 instrument configured as the master,
an additional 31 slave IOEM, REM and/or 5X00 instruments can be added
to the network. The network uses RS485 protocol;
•
field upgradable firmware, including RS232 port for firmware updating;
•
power and communication status LEDs see Troubleshooting; Status
LED, page 85.

Introduction

*AquaManager adds the ability to:
•
configure IOEM and REM channels to 5X00 networked instruments;
•
configure, graph and map IOEM systems and REM channels;
•
log and view IOEM channel system data and REM events;
In addition to the common features listed above, IOEM functionality includes:
•
4 (IOEM-4) or 8 (IOEM-8) 8 selectable I/Os; I/Os can be configured
as digital, analog (0-1VDC, 0-5VDC, 4-20/mA) or temperature inputs;
•
4 (IOEM-4) or 8 (IOEM8) selectable I/Os can be configured as 5X00
instrument system 4/20mA outputs;
In addition to the common features listed above, REM features include:
•
four (4) onboard output relays rated at 250VAC@10AMPs;
See IOEM and REM Product Specifications, starting on page 12, for complete
instrument specifications.
Use of this equipment for something other than the intended use of the instrument is prohibited.
Figure 1.1 shows an REM front panel and enclosure. (IOEM front panel and
enclosure are identical.) Compression fittings located on the bottom of the enclosure provide liquid-tight connections for wiring peripheral devices and IOEM
and REM devices and components.

Figure 1.1
IOEM/REM Safey and Installation Guide
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IOEM product description
IOEM instruments are configured as slave devices on an RS485 network. IOEM
channels (I/Os) are used by 5X00 systems as additional I/Os on the network. IOEM
instruments have either 4 I/O channels (IOEM-4) or 8 I/O channels (IOEM-8).
AquaManager (PC software) is required to configure an IOEM mode on a
network. IOEM channels can be configured in the following three (3) ways:
1. As an Input - configure IOEM channel as a digital, analog (0-1V, 0-5V,
4/20mA) and/or temperature input. These inputs are configured, monitored
and controlled using a 5X00 instrument E-Aux system. See IOEM input channel/eaux configuration-page 72.
2. As a 4/20mA PID output control device (such as a valve) to control any 5X00
instrument pH, ORP, temperature, Conductivity, DO, non digital aux and E-Aux
system. 5X00 system must be configured in PID 4/20mA control mode. See
page “Configure 5X00 system for IOEM PID output control device” on page 77
3. As an output, converting a 5X00 system input to a 4/20mA output signal to
be used by some external device such as a PLC- page 76- Convert any non
digital 5X00 sytem [pH, ORP (mv), temperature (F/C), Conductivity, (mS/μS),
DO (%sat/mg/l), aux and E-Aux] to a 4/20mA output signal.
IOEM use case input-5X00 instruments have 8 eaux systems. 5X00 instrument eaux
systems are used to allow peripheral input devices (digital, analog and temperature)
to be monitored, controlled and alarmed across a network. An example - a 4/20mA
pH probe is configured and wired to an IOEM instrument, the 4/20mA ph probe
input is configured at a 5X00 eaux system. The 4/20mA ph system can now be
monitored, controlled and alarmed over the network. E-Aux “virtual systems” can
be configured in a variety of ways that allow flexibility to the user.
IOEM use case 4/20mA output - a 5200A instrument’s pH value is sent as a 4/20mA
signal to a third party device such as a PLC. The 4/20mA signal can then be used
by the third party device for additional processing.
notes:
-

One IOEM input can be assigned to multiple 5X00 E-Aux systems.
One IOEM 4/20mA output can be assigned to only one 5X00 system.

REM product description
REM instruments are configured as slave devices on an RS485 network. REM
channels (outputs) are used by 5X00 systems as additional relay outputs on the
network. REM instruments have 4 relay outputs that are used to connect peripheral
devices . These peripheral devices are used to control and/or alarm networked 5X00
instrument systems.
IOEM/REM Safey and Installation Guide
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REM use case output-The master 5X00 instrument receives information that a slave
5X00 DO system on the network is in DO low control range. The DO low control
relay for this 5X00 slave is configured to relay 2 on a networked REM. The master
sends a command to the networked REM that relay 2 needs to energize to control
slave 5X00’s low DO value. Slave REM instrument, relay 2, energizes until the
master receives a message from the slave 5X00 DO system value is ≥ to that DO
system’s setpoint.
note:
-

Multiple 5X00 systems can be assigned to the same relays.

Preview of User Manual
This manual includes safety, installation, wiring and maintenance information for
IOEM and REM instruments. This manual is intended to be used with 5X00
instrument manuals and AquaManager PC program help system for IOEM
and REM configuration.
Read Chapter 2 “Safety Information,” starting on page 16, before installing or
configuring IOEM and REM systems.
Chapter 3 “Installation,” starting on page 24, provides information on how to
install the IOEM and REM components, and peripheral devices. Only qualified
people should install IOEM and REM expansion modules. Do not attempt to install
or configure these devices if you are not qualified to do so. If information is not
clear, DO NOT PROCEED until clarification can be obtained. All wiring involving
connections to main power must be performed by a qualified licensed electrician
and must conform to all locally applicable electrical codes.
Chapter 4 “Using AquaManager to configure IOEM and REM Channels,” starting
on page 70, provides quick start guides on how to use AquaManager to configure
IOEM and REM I/O channels to 5X00 instrument systems. 5X00 user manuals contain detailed information on 5X00 instrument menu structure and how to properly
configure IOEM and REM instruments to 5X00 systems.
“Notes” are presented at the end of certain manual sections to provide additional
information to help clarify IOEM and REM operation and features.
Appendices include information on Unpacking & Inspection, Troubleshooting,
Declaration of Conformity, Alpha “A” curve (a reference for temperature sensors)
Parts and Accessories, Warranty, Contact Us and Recycling information.
An index is provided starting on page 96.
IOEM/REM Safey and Installation Guide
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Product Specifications
To ensure accurate and reliable performance, operate IOEM and REM expansion
modules according to specifications provided in the following tables. Damage and/
or incorrect operation could result if these specifications are not followed and would
not be covered under manufacturer’s warranty, see page 93.
Use of this equipment for something other than the intended use of the instrument
is prohibited.

Analog input ranges

Accuracy

Resolution/Other

0-1.0 VDC

0-1.0VDC: ± 3% ± 10 mV

user selectable (0), (0 .0), or
(0.00)

0-5.0 VDC

0-5.0VDC: ± 3% ±15 mV

user selectable (0), (0 .0), or
(0.00)

4-20mA

4-20 mA: ± 3% ±100μA

user selectable (0), (0 .0), or
(0.00)/
4/20mA I/O circuits are able to
source current as well as sink
current.

Product specifications are subject to change without notice. Visit www.ysi.com to
view the most recent product specifications.

Environmental Specifications
Environmental Category

Operating Range

Temperature

0 to 45˚C (32 to 113˚F)

Enclosure Rating

NEMA 4X (direct exposure to outside conditions),
IP65

Compression Fitting Rating

IP 68/NEMA 6 (liquid tight)

Electrical Safety

ETL Listed (Product conforms to UL 61010-1 3rd
edition and CAN/CSA C22.2#61010-1 3rd edition)*
EMC/ESD: Complies with FCC Part 15 (USA),
ICES-003 (Canada), EMC Directive 2004/108/EC
(European Union and Australia/New Zealand)*

Other

RoHS Directive 2011/65/EU, WEEE 2002/96/EC,
FCC*

*See Appendix 3 Declaration of Conformity - page 88.

IOEM Input/Output System Specifications

Accuracy
Temperature
Range
Sensor type
10,000 ohm @ 25°C
thermistor

Resolution

0 to 45°C (32
to113°F)

± 0.2°C

0.1°C

Aux Output Type

Accuracy

4/20mA

4-20 mA: ± 3% ±100μA

REM Output Specifications
Outputs

4 on-board relays

250VAC@ 10AMPs
switching capacity; type:
SPDT.

Component and System (Non Input) Specifications
Hardware

Input type

Digital

There are 4 (IOEM-4) or 8 (IOEM-8) I/O channels that allow digital,
analog (0-1.0VDC, 0-5.0VDC, or 4-20mA) and temperature input
configuration. These inputs are configured to a 5X00 instrument’s
r E-Aux systems allowing for additional instrument inputs. 4-20
mA output channels can be assigned to temperature, pH, ORP,
Conductivity or to Aux and E-Aux input systems.
Each I/O circuit is fully isolated with its own ground.
Range

Digital input

n/a

dry contact open/close

IOEM/REM Safey and Installation Guide
12

System

System Feature

Specification

diagnostic troubleshooting
LEDs
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Power: There are two IOEM and REM power options. The DC version can only be
powered by DC power. The AC version can be powered by AC or DC power.
Power for DC
Version:

external 12VDC power
source

9-16.5VDC; 2A

Power for AC
Version:

internal AC switching power
supply

100-240VAC; 50-60Hz; 0.5 Amp

Both AC and
DC versions:

lithium battery (for real time
clock)

2032 lithium ion

Electronics

ARM7 embedded microprocessor

2

Safety

Firmware
Feature

Specification

Flash Memory

Firmware field upgradable with
local PC connection

Data filtering

reads 2-3 times per second and
readings are averaged

Feature

Specification

RS232 required for firmware
upgrading

up to 100 ft (30m)

Communication

Instrument to Instrument Networking
Feature

Specification

With a 5X00 instrument configured as the master, an additional 31 slave IOEM, REM
and/or 5X00 instruments can
be added to the network.

The network uses RS485 protocol.
RS485 up to 4000 ft (1220m)
entire network distance

Feature

Other PC Requirements

Runs on Windows 2000/
XP/Vista/Windows 7 & 8
Windows operating systems
32-bit and 64-bit

VGA display card
CD-ROM Drive
Total RAM Installed: 16MB or
greater
100 MB free hard-disk space

AquaManager

-IMPORTANT safety information.
Read this chapter before installing IOEM and REM components and peripheral devices.
IOEM/REM Safey and Installation Guide
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THIS IS IMPORTANT
Take time to be safe when working on electrical circuits and equipment. It could
save your life. Avoid unsafe acts and conditions. Do not operate or install the IOEM
and REM before reading this chapter. Installing the IOEM and REM involves wiring high voltage equipment. Follow all provided safety information. Installation
must be performed by someone who understands the dangers of, and is qualified
to, wire electrical devices. If information or instructions are not clear, DO NOT
PROCEED until clarification can be obtained.

Safety
-

CAUTIONS are used when personal injury or damage to equipment
can result if safety information is not followed

-

.Les notices ATTENTION sont utilisées lorsque des blessures ou des
dommages à l’équipement pourraient être causés si les consignes de
sécurité n’étaient pas suivies.

)(
) appear in the left margin of the page to highlight
These symbols (
safety information as it applies to a particular installation or operation step.

ALWAYS:

A complete list of all safety cautions is provided below. All warnings are provided
in English and French.

Follow basic safety rules when working with or near high voltage circuits. The
IOEM and REM is a high voltage instrument using 110v. Peripheral devices
may also be high voltage devices.

Install and use the IOEM and REM only in accordance with information documented in this manual.

Consider the result of each act. Keep away from live circuits. Do not change
parts or make adjustments inside the equipment with high voltages on.
Do not service alone.
Do not tamper with interlocks. Safety devices such as interlocks, overload
relays, and fuses should never be altered or disconnected except for replacement. Safety protection devices should never be changed or modified without
a clear understanding of what effect the modification will have on the system.
Do not ground yourself.
Do not energize equipment if there is any evidence of water leakage.

Warnings and Cautions

Warnings
WARNINGS are used when personal injury or death can result if safety information is not followed.
Les AVERTISSEMENTS sont utilisés lorsque des blessures graves ou mortelles
pourraient être causées si les consignes de sécurité n’étaient pas suivies.
WARNING: All wiring that involves connections to mains power must be
performed by a qualified licensed electrician, and must conform to all locally
applicable electrical codes.
AVERTISSEMENT : tous les câblages comportant une connexion à l’alimentation
secteur doivent être réalisés par un électricien qualifié et doivent être conformes
aux codes électriques applicables.

-

WARNING - RISK OF ELECTRIC SHOCK This symbol identifies
installation and operation procedures that can result in personal injury
or death if safety information is not followed.

WARNING: Do not make connections while power is applied. Turn off power
and assure power “Lockout” before installing or servicing to avoid contact with
electrically powered circuits. This includes working on devices connected to
the relay outputs and auxiliary input systems. Disconnect external power to
the IOEM and REM before connecting or disconnecting components and/
or peripheral devices.

-

AVERTISSEMENT – RISQUE DE CHOC ÉLECTRIQUE. Ce
symbole identifie les procédures d’installation et d’opération pouvant
entraîner des blessures ou la mort si les consignes de sécurité ne sont
pas suivies.

AVERTISSEMENT: n’effectuez aucune connexion alors que le circuit est sous
tension. Coupez l’alimentation et assurez l’interdiction du courant avant toute
installation ou tâche d’entretien afin d’éviter d’entrer en contact avec des circuits
sous tension. Cela comprend tout travail sur des appareils connectés à des sor-

Safety information is presented in this manual in one of two ways:

IOEM/REM Safey and Installation Guide
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Safety
ties de relais et des systèmes d’entrée auxiliaires. Déconnectez l’alimentation
externe du modèle IOEM and REM avant de connecter ou de déconnecter
des composants et/ou des appareils périphériques.

WARNING: Do not overload relays. Verify that the surge current at startup
does not exceed the relay load ratings. Be familiar with all safety information
regarding installing and servicing peripheral devices.

WARNING: A switch or circuit breaker shall be included in the building where
the IOEM and REM is installed. The disconnecting device should be in close
proximity to the equipment and within easy reach of the operator. The disconnecting device shall be marked for the equipment.

AVERTISSEMENT: ne surchargez pas les relais. Vérifiez que la surtension
de démarrage ne dépasse pas la capacité de charge nominale du relais. Prenez
connaissance de toutes les consignes de sécurité concernant l’installation et
l’entretien des appareils périphériques

AVERTISSEMENT: un commutateur ou disjoncteur doit être installé dans le
bâtiment où le modèle IOEM and REM est installé. Le dispositif de déconnexion
doit se trouver à proximité de l’équipement et à portée de l’opérateur. Le dispositif
de déconnexion doit indiquer l’équipement auquel il se rapporte.

WARNING: The IOEM and REM is not fused. Fuses used in any peripheral
equipment should be removed and replaced only after the circuit has been deenergized. When a fuse blows, it should be replaced only with a fuse of the same
current and voltage ratings. Circuits should be carefully checked before fuse
replacement. A burned out fuse is often the result of circuit fault.

WARNING: The covers of fuse boxes and junction boxes should be kept securely
closed except when servicing.
AVERTISSEMENT: le couvercle des boîtes à fusibles et des boîtes de dérivation
doit être maintenu fermé sauf lors des tâches d’entretien
WARNING: Electric sparks and chemical exposure are potential dangers when
working with batteries. Use necessary precautions and follow all manufacturer’s
directions.
AVERTISSEMENT: l’exposition à des étincelles ou produits chimiques est un
danger potentiel inhérent à tout travail sur des batteries. Observez les précautions
nécessaires et suivez les consignes du fabricant.
WARNING: Ground the IOEM and REM. See Ground IOEM and REM - page
31. The sensitivity and stability of the IOEM and REM will be impaired if
the IOEM and REM is not grounded. To avoid possible electrical shock or damage to the equipment, connect earth ground to the IOEM and REM I/O board.
In addition to grounding the IOEM and REM, all tanks should be electrically
grounded using a ground probe.
AVERTISSEMENT: mettez le modèle IOEM and REM à la terre. Voir Mise
à la terre du modèle IOEM and REM. La sensibilité et la stabilité du modèle
IOEM and REM seront affectées s’il n’est pas mis à la terre. Pour éviter toute
possibilité de choc électrique ou d’endommagement de l’équipement, connectez
le fil de terre à la carte d’E/S du modèle IOEM and REM. En plus de la mise à la
terre du modèle IOEM and REM, tous les réservoirs doivent être mis à la terre.

IOEM/REM Safey and Installation Guide
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AVERTISSEMENT: le modèle IOEM and REM ne contient pas de fusible. Les
fusibles utilisés par les équipements périphériques doivent être retirés et remplacés uniquement après que le circuit a été mis hors tension. Lorsqu’un fusible
est grillé, il doit être remplacé uniquement par un fusible d’une tension et d’un
ampérage nominaux identiques. Les circuits doivent être soigneusement vérifiés
avant le remplacement d’un fusible. Un fusible grillé est souvent le résultat d’une
défaillance de circuit
WARNING: Do not apply power to the IOEM and REM until all electrical connections are verified and secured.
AVERTISSEMENT: ne mettez pas le modèle IOEM and REM sous tension tant
que les connexions électriques n’ont pas été vérifiées et sécurisées.
WARNING. Disconnect external power before wiring. Do not run high and
low voltage wires through the same conduit or bulkhead fitting. Protect internal
electronics. See “Sealants, Desiccants, and Securing Expansion Modules” in
5X00 User’s Manual
AVERTISSEMENT: Déconnectez l’alimentation externe avant d’effectuer le
câblage. Ne pas acheminer les câblages basse tension et haute tension dans le
même conduit ou le même raccord de traversée de cloison. Protéger les appareils
électroniques internes. Voir la section « Scellants, dessiccants et fixation des
modules d’expansion » dans le guide d’utilisation du modèle 5X00
WARNING: The equipment should be positioned so that the power cord can
easily be disconnected.

IOEM/REM Safey and Installation Guide
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AVERTISSEMENT: l’équipement devrait être placé de façon à ce que le cordon
puisse être facile à débrancher.

Cautions
CAUTIONS are used when personal injury or damage to equipment can result if
safety information is not followed.
Les notices ATTENTION sont utilisées lorsque des blessures ou des dommages à
l’équipement pourraient être causés si les consignes de sécurité n’étaient pas suivies.
CAUTION: The IOEM and REM utilizes sensitive solid state devices that can
be damaged by static shock. Installers must observe accepted ESD (ElectroStatic Discharge) procedures while connecting wires to the IOEM and REM
control board.
ATTENTION: les modèles d’IOEM (module d’expansion d’entré et de sortie)
et de REM (module d’expansion de relais) utilisent des appareils transistorisés
sensibles pouvant être endommagés par des décharges d’électricité statique.
Les installateurs doivent observer les procédures de protection acceptées contre
les décharges électrostatiques lors du câblage à la carte de l’IOEM et du REM.

Safety
CAUTION: Surge protectors are strongly recommended to protect from secondary surges and lightning. Surge suppression devices should be located on
the AC line supplying power to the IOEM and REM. See Lightning and Surge
Protection - page 65.
ATTENTION: Il est fortement recommandé d’utiliser des limiteurs de surtension
pour protéger l’installation contre les surcharges secondaires et les éclairs. Les
limiteurs de surtension doivent être placés sur le câblage c.a. de l’alimentation
à l’IOEM (module d’expansion d’entré et de sortie) et au REM (module
d’expansion de relais). Voir la section « Protection contre les surcharges et les
éclairs » à la page “Lightning and Surge Protection” on page 65.
CAUTION: It is essential that all low voltage wiring, including sensor wiring
be run in separate cable or conduit from high voltage wiring.
ATTENTION: Il est essentiel que le câblage basse tension, y compris le câblage du
capteur, soit acheminé par un câble ou un conduit séparé du câblage haute tension.

CAUTION: Sensors are powered by the IOEM and REM instrument and use
a “floating” ground reference. This requires that the probe not be individually
grounded.
ATTENTION: Les capteurs sont alimentés par les instruments de l’IOEM (module
d’expansion d’entré et de sortie) et du REM (module d’expansion de relais) et
sont utilisés comme référence « flottante » au sol. Cela exige que les capteurs
ne soient pas mis à la terre individuellement..
CAUTION: Power supply voltage above 16.5 VDC may permanently damage
the IOEM and REM. See Wire DC Power - page 38.
ATTENTION: Toute alimentation à une tension supérieure à 16,5 V c.c. risque
d’endommager de manière permanente l’IOEM (module d’expansion d’entré et
de sortie) et le REM (module d’expansion de relais). Voir la section « Alimentation c.c. des câbles » à la page “Directions to Wire DC Power/DC Backup
Power” on page 38.
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This page left intentionally blank.

-Installing & wiring IOEM and REM, components, and
peripheral devices.
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Installation and Wiring

Hardware Installation
Correctly install IOEM and REM system components and peripheral devices to
ensure accurate data collection and reliable operation. First, determine what monitor,
control, alarm and output functions the IOEM and REM expansion modules will
perform. Because system components are wired to IOEM and REM instruments,
it is important to determine where and how components will be installed and configured. Preparing a system schematic (figure 3.1) is helpful.

Installation and Wiring
Step 6 - wire a network of 2 - 32 instruments, including slave address dip switch
configuration
Step 7 - wire communications hardware
See Chapter 4 “Configuring IOEM and REM Channels,” starting on page 70, for
directions on configuring IOEM and REM expansion modules using AquaManager
PC software.
Tools and supplies needed for hardware installation:
•

Phillips-head screwdriver to remove IOEM and REM front panel to access board assembly
•
necessary tools for cutting mounting holes in mounting brackets (rail
mount)
•
electric drill and bits for mounting IOEM and REM (panel or rail) and
for drilling rubber grommets in bulkhead fittings
•
small flat-head screwdriver to terminate wires on the IOEM and REM
board’s pluggable terminal strips
•
wrench to tighten the bulkhead fittings following system component wiring
•
wire strippers
•
contactors may be required for relay wiring; see contactor wiring - page
42
Optional accessories for hardware installation:
•
surface mount hardware (included)
•
rail mount hardware
•
weather shield hardware
•
cabling for network wiring
•
wiring not supplied with components and/or peripheral devices

Step 1 Install IOEM and REM
Select a mounting location and method to mount the IOEM and REM.

Location Considerations
Figure 3.1
Hardware installation steps (not all steps required for all applications):
Step 1 - install IOEM and REM instrument
Step 2 - ground IOEM and REM
Step 3 - wire power
Step 4 - wire relays - REM only
Step 5 - wire I/Os - IOEM only
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The IOEM and REM must be located:
•
above any level where water damage can occur
•
away from extremely high or low temperature sources
•
away from vibrating surfaces
•
at least two (2) feet (.7 m) from any high voltage conduit
•
away from electromagnetic, radio, AC motor, transformer, or antennas
•
so the front panel can be fully opened and serviced
•
so system component wires are run as specified in this manual and according to all local applicable electrical codes.
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WARNING: The equipment should be positioned so that the power cord can
easily be disconnected.
AVERTISSEMENT: l’équipement devrait être placé de façon à ce que le cordon
puisse être facile à débrancher.

Mount the IOEM and REM
Select surface or rail mount option. Install the weather shield for outdoor installations.

Surface Mount
Mount IOEM and REM to any flat surface using mounting brackets. Mounting
brackets and screws are included with IOEM and REM devices.
1.
2.
3.

4.

Installation and Wiring
Rail Mount
Mount IOEM and REM to handrail or pipe 1 to 1.5” (2.5 to 3.8cm) in diameter.
The rail mount kit (YSI model number 6509) includes u-bolts, a pre-drilled metal
plate, washers, and nuts.
1. Drill holes in the mounting brackets to fit the u-bolts. Use the pre-drilled
metal plate as a template.
2. Fasten the mounting brackets to the back of the IOEM and REM with the
mounting screws as shown in figure 3.2.
3. Tighten the screws, securing the brackets to the IOEM and REM.
4. Place the u-bolts around the rail securing the IOEM and REM to the pipe
or rail by feeding through the pre-drilled holes on the mounting brackets
as shown in figure 3.3.
5. Secure the metal plate over the u-bolts and around the rail or pipe using
washers and nuts provided.
6. Tighten the screws, securing the IOEM and REM to the rail.

Fasten the mounting brackets to the back of the IOEM and REM with the
mounting screws - figure 3.2.
Tighten the screws, securing the brackets to the back of the IOEM and
REM enclosure.
Fasten the IOEM and REM mounting brackets to the mounting surface
with the mounting screws provided - figure 3.2. Make sure screws adequately secure IOEM and REM to surface.
Tighten the screws, securing the IOEM and REM to the surface.

Figure 3.3

Install the Weather Shield
Install the weather shield for outdoor installations. The weather shield can be used
with either a surface or a rail mount. The weather shield kit includes a weather
shield, u-bolts, pre-drilled metal plate, washers, and nuts.

Figure 3.2
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1.

2.

3.

First complete steps 1-2 under Surface Mount or steps 1-3 under Rail
Mount depending on the type of installation. Note: You may need to
modify the pre-drilled holes in the weather shield depending on the
mounting location.
At step 3 (surface mount) or step 4 (rail mount), attach the weather shield
to the surface or rail with the metal plate installed to secure the weather
shield to the surface or rail. Figure 3.4 shows the weather shield installed
for a rail mounted IOEM and REM.
Tighten the screws, securing the weather shield.

Installation and Wiring
locations. IOEM and REM ground wires (also called drain wires) are terminated
to the metal plate as well.
The front panel must be open when wiring system components, peripheral devices
and RS232 communication cabling. See Accessing the I/O and REM Board - page
32. It is recommended that some system configuration and testing be done in
conjunction with hardware installation. This ensures that peripheral devices are
wired correctly. Refer to Chapter 4, “Configuring IOEM and REM Systems,” page
70, for references to 5X00 instrument user manuals for proper configuration of
all IOEM and REM instrument systems.

WARNING: Follow all safety information and local electrical codes when
wiring IOEM and REM system components and peripheral devices. Proper
wire gauge should be determined based on voltages and wire/cable length. Incorrect wiring can result in damage to you or to the equipment. Improper wiring
can also result in ground loops.
AVERTISSEMENT : suivez toutes les consignes de sécurité et les codes électriques en vigueur lors du câblage des composants du système IOEM and REM
et des appareils périphériques. Le calibre correct des câbles doit être déterminé
en fonction des tensions et de la longueur des câbles/fils. Un câblage incorrect
peut entraîner des blessures et endommager l’équipement. Un câblage incorrect
peut également entraîner des boucles de mise à la terre.

Figure 3.4

Wiring Information
System components must be wired correctly to ensure reliable performance and
accurate functionality. Directions are provided in this section for wiring all IOEM
and REM components and peripheral devices. Proper Earth Ground is required to
ensure safe operation-see Wire and Ground IOEM and REM, page 33. Power
mains to be fed by a Listed/Certified 15/20Amp Breaker for SC protection.

PCBs
There is a single pcb inside IOEM-4 and REM enclosures. IOEM-8 expansion
modules have an additional pcb providing for an additional 4 I/O channels. All
components including power, network, RS232 communication, inputs/outputs
(IOEM) and relay outputs (REM) are wired to one board. There is a metal plate
covering the PCB(s). The metal plate is labeled with letters. These letters correspond
to a label, affixed to the inside of the front panel which identifies wire termination
IOEM/REM Safey and Installation Guide
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IOEM and REM Bulkhead Compression Fittings

Installation and Wiring
IOEM wiring diagram located inside front panel

Eight bulkhead compression fittings [4@ 3/8”(.9525cm), 2 @ 3/4” (1.905cm), and
2@ 1/2” (1.27cm)] located on the bottom of IOEM and REM enclosures provide
watertight connections for system component wiring-figure 3.5 Rubber grommets
must be “pushed out” of the compression fitting housing and drilled for wiring installation. The drill bit diameter should be slightly smaller than the wire diameter
so that a watertight seal can be made. Rubber grommets can be frozen (put in a
freezer for 1 hour) and then easily drilled to the required diameter. Some pre-drilled
rubber grommets are supplied with IOEM and REM. devices.

REM wiring diagram located inside front panel

Figure 3.5

Accessing the I/O and REM Board
The I/O board is accessible when the IOEM and REM front panel is open. The letters on the metal plate identify wire termination locations and pluggable terminal
strip locations on the PCB board. Letters on the metal plate correspond to the wiring
diagram located on the inside of the front panel.
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Open Front Panel to Access I/O and REM Board

Installation and Wiring

Step 2 Ground IOEM and REM

WARNING: Disconnect external power to the unit before doing any wiring.

WARNING: Ground the IOEM and REM to avoid possible electrical shock or
damage to the equipment.

AVERTISSEMENT : déconnectez l’alimentation externe de l’unité avant
d’ouvrir le panneau avant.
1.
2.

Loosen the 4 mounting screws connecting the front panel to the back
enclosure. Captive screws remain in front panel after loosening.
Unhinge the front panel by lifting the latch up so the hinge is released
from the front panel. The rubber gasket seated in the front panel should
remain in the front panel lid.

Close Front Panel
1.

2.

3.

4.
5.

Verify all installed components and peripheral equipment have secure
connections and that there are no bare wires that could cause a short
inside the enclosure.
Tighten bulkhead fittings after connecting all wiring. (Hand tighten fittings around rubber grommet. Tighten bulkhead fittings into enclosure
with wrench being careful to not overtighten.)
Follow information in Sealants, Desiccants and Securing the Monitor
Section - page 66 to safeguard against damage to internal electronic
components.
Make certain the gasket in the front panel lid is in place and not twisted
or damaged.
Tighten mounting screws, making sure not to cross thread. The screws are
stainless steel, and the receiving threads are brass. Do not over-tighten!
CAUTION: The IOEM and REM utilizes sensitive solid state devices that can
be damaged by static shock. Installers must observe accepted ESD (ElectroStatic Discharge) procedures while connecting wires to the IOEM and REM
control board.
ATTENTION : les modèles d’IOEM (module d’expansion d’entré et de sortie)
et de REM (module d’expansion de relais) utilisent des appareils transistorisés
sensibles pouvant être endommagés par des décharges d’électricité statique.
Les installateurs doivent observer les procédures de protection acceptées contre
les décharges électrostatiques lors du câblage à la carte de l’IOEM et du REM.
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AVERTISSEMENT : mettez le modèle IOEM and REM à la terre afin d’éviter
tout risque de choc électrique ou d’endommagement de l’équipement.
Ground the IOEM at location F on the metal plate. Ground the REM at location
G on the metal plate. Other IOEM and REM system components can be grounded
at these same locations. Titanium ground rods can also be used to ground peripheral
equipment.
In addition to grounding the IOEM and REM, all tanks should be electrically
grounded via a ground probe.

Directions to Ground IOEM and REM
WARNING: Disconnect external power to the unit before wiring.
AVERTISSEMENT : déconnectez l’alimentation externe de l’unité avant
d’effectuer un câblage quelconque.
1.
2.
3.
4.

5.
6.

Perform step 1 of IOEM and REM installation.
Open front panel - page 32.
Remove screw from location F (IOEM)/G (REM).
Feed ground wire through drilled hole in rubber grommet and to location
F (IOEM)/G (REM) on metal plate. Ground wire gauge must conform
to all locally applicable electrical codes.
Install a ring (eyelet) or spade (fork) terminal onto the ground bare wire
before terminating ground wire to ground location.
Return screw at F (IOEM)/G (REM) over terminal connection of ground
wire.

CAUTION: Run high and low voltage cables through separate bulkhead and
conduit.
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Installation and Wiring
7.

IOEM ground

8.
9.

Terminate other end of the earth ground wire to a cold water pipe, steel
rod, copper pipe, or earth ground.
Complete other wiring to IOEM and REM.
Close front panel - page 32.

Step 3 Wire Power
IOEM and REM expansion modules are available with either AC or DC power. The
DC version can only be powered by DC power. The AC version can be powered by
either AC or DC. If an AC version is properly wired and configured for AC and
DC backup, and AC power fails, the instrument will be powered by DC backup
which supplies backup power. No user configuration is needed for the DC battery
backup and low DC power alarm to function.
CAUTION: At 120VAC, the IOEM and REM draws 25 watts (~0.2 amps).
Use wiring suitable for that load following all safety information and local
electrical codes.
Back up power is recommended when operating with AC power. Backup power
can be supplied by 12VDC or UPS battery source.

Wire AC Power
REM ground

The AC power option includes an integrated universal (worldwide) AC switching
power supply, allowing AC power from any AC receptacle 100-240VAC. AC power
wires are terminated at location C on I/O Board.

Directions to Wire AC Power
WARNING: Disconnect external power to the unit before wiring.
AVERTISSEMENT : déconnectez l’alimentation externe de l’unité avant
d’effectuer un câblage quelconque.
1.
2.
3.
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Perform steps 1 - 2 of IOEM and REM installation.
Open front panel - page32.
Install ferrite bead on to the line cord (AC power cord). The ferrite bead
(YSI p/n 606399, ferrite bead figure below) should be installed as close
to the module board as possible. Strip approximately 16.5 cm (6.5 in) of
insulating jacket off the end of the cord. Feed AC power cable through
drilled hole in rubber grommet in compression fitting to location (IOEM)
B/ (REM) C and then pass the conductors through the ferrite bead 1
time. This will result in a loop of each conductor around the bead (ferrite
bead assembled figure below).
IOEM/REM Safey and Installation Guide
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Installation and Wiring
Ferrite bead (YSI p/n 606399)

IOEM AC power

Ferrite bead assembled
REM AC power

CAUTION: Run high and low voltage cables through separate bulkhead and
conduit.
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Installation and Wiring
4.

Terminate AC power wires to pins “G” (ground), “L1”, and/or “L2/N”
according to applicable local electrical codes. Use minimum 18 gauge,
3 wire power cord.

3.

Feed DC power cable through drilled hole in rubber grommet to location
A. The terminal strip is removable.

CAUTION: Run high and low voltage cables through separate bulkhead and
CAUTION: It is recommended to use only the power cord provided to prevent
exceeding the current draw of the AC power supply.

conduit.
4.

5.
6.
7.

Complete other wiring to IOEM and REM.
Close front panel - page 32.
Test AC power. PCB PWR status led will be solid green.

Terminate DC power wires to pins (-) and (+) according to manufacturer
instructions and any applicable local electrical codes.

IOEM DC power

Wire DC Power and backup power
The IOEM and REM may be powered by most 9.0-16.5 VDC sources that provide
800mA of current and are isolated from mains supply by double or reinforced
insulation. The DC backup power source is user-supplied and can come from a
variety of choices including lead acid, gel cell, or UPS (with 12VDC transformer)
external batteries. DC power wires are terminated at location A on the IOEM and
REM boards.
Notes:
-

-

The IOEM and REM does not charge batteries. Quality assurance maintenance procedures should be established if batteries are to be fully
powered when used as back-up power source.
Power supply voltage above 16.5 VDC may permanently damage the
IOEM and REM.
When back up voltage falls below 9.0 volts, the IOEM and REM ceases
to operate properly.
Some switching DC power supplies not supplied by YSI may result in
noisy readings.

Directions to Wire DC Power/DC Backup Power
WARNING: Disconnect external power to the unit before wiring. Follow
all manufacturer’s safety and installation instructions when providing power to
the IOEM and REM via a DC power supply.
AVERTISSEMENT : déconnectez l’alimentation externe de l’unité avant
d’effectuer le câblage. Suivez toutes les consignes de sécurité et d’installation
du fabricant lorsque vous fournissez de l’alimentation au modèle IOEM and
REM par un bloc d’alimentation à courant continu.
1.
2.

Perform steps 1 - 2 of IOEM and REM installation.
Open front panel - page 32.
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Installation and Wiring

Directions to Wire Relay Outputs

REM DC power

WARNING: Disconnect external power to the unit before wiring. If any of
the relay contacts are connected to a “hazardous-live” circuit, ALL contacts on
ALL relays must be considered “hazardous-live” and appropriately protected
from user contact outside the IOEM and REM enclosure.
AVERTISSEMENT : déconnectez l’alimentation externe de l’unité avant
d’effectuer le câblage. Si un contact de relai quelconque est connecté à un
circuit sous tension dangereuse, TOUS les contacts de TOUS les relais doivent
être considérés comme étant sous tension dangereuse et doivent être protégés
de façon adéquate de tout contact de l’utilisateur hors du boîtier du modèle
IOEM and REM.
1.
2.
3.

Perform steps 1 - 3 of IOEM and REM installation.
Open front panel -page 32.
Feed relay device wires through drilled hole in rubber grommet and to
locations B. The terminal strip is removable.

CAUTION: Run high and low voltage cables through separate bulkhead and
conduit.
5.
6.
7.

Complete other wiring to IOEM and REM.
Close front panel - page 32.
Test DC power. PCB PWR status led will be solid green.

4.

Terminate relay device wires according to relay number. Wire devices to
NC or NO and C pins depending on device configuration.

REM relay termination

Note:
-

The IOEM and REM will not power up if DC power supply wires are
terminated incorrectly.

Step 4 Wire REM Relay Outputs
The REM has four (4) on board non-fused relays rated at 250VAC@10AMPs. REM
relays can be configured to any 5X00 system, sensor control, alarm and timer system.
Terminate relay device wires to Normally Open (NO), Normally Closed (NC), and
Common (C) sockets as required for the application. (See IOEM and REM board
wiring diagram on inside of front panel for identification of relay number and pin
position.) Relays 1-4 are terminated at location B.
CAUTION: Do not overload relay(s). Check manufacturer specifications for

inductive current/amp at power up. Use a contactor if necessary - figure 3.6.
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Installation and Wiring
5.
6.
7.

8.

Complete wiring all REM relays that will be used in application.
Close front panel -page 32.
Configure 5X00 system relays using AquaManager PC software or directly
through the instrument front panel. Complete relay configuration information is provided in 5X00 user manuals. Use AquaManager PC software
Help system to configure relays from a PC.
Test relays. See System>Service>Test Relay menu, 5X00 instrument user
manuals.

Wiring a Contactor
The four onboard relays are rated at 250VAC@10AMPs. Contactors should be
used for devices drawing current loads higher than relay specification. See figure
3.6 for contactor wiring.

Step 5 Wire I/Os on IOEM
Wire IOEM channel devices according to their application. IOEM channels can be
configured as input or output devices. See IOEM configuration options starting on
page 70. IOEM channels can be configured one of three (3) ways: 1) as an input
to use with one of the 5X00 instrument’s E-Aux systems which E-Aux system would
be configured to monitor, control and/or alarm and datalog that E-Aux system.
(E-Aux systems are also referred to as “virtual inputs.”) 2) as a 4/20mA output for
5X00 sensor systems including pH, ORP, conductivity, temperature, DO and aux and
E-Aux systems. The 4/20mA output signal can then be used by another connected
device such as a PLC. 3) as an PID 4/20mA output for 5X00 pH, ORP, conductivity, temperature, DO, and non digital aux and E-Aux systems allowing PID control
devices, such as a value, to open and close based on system value. IOEM-8s have
8 I/Os which are terminated at locations G and H. IOEM-4s have 4 I/Os which
are terminated at location G.

Note:
-

Contactor must meet the electrical requirements of the load.

YSI REM contactor wiring

Diagrams and directions for wiring all input and output types are provided in the
following manual sections. Use IOEM wiring diagram on inside of front panel for
identification of I/O channel number and pin position.

IOEM input configuration
wire contactor power to “C” pin
wire second wire to “NC”/”NO” as required for application

IOEM channels can be configured for 0-1volt, 0-5volt, 4/20mA (powered and
unpowered), digital and temperature input devices. These input devices use 5X00
instrument E-Aux systems to monitor, control and alarm the specific input values.
Note:
-

All IOEM inputs have input protection, the maximum input voltage
should not exceed 6 VDC.

Directions to Wire (non temperature) IOEM Inputs
Contactor

WARNING: Disconnect external power to the unit before wiring.

Switched Power

X
Power for Contactor
Coil

Contacts

Blower

AVERTISSEMENT : déconnectez l’alimentation externe de l’unité avant
d’effectuer un câblage quelconque.

Power for Blower

Figure 3.6

1.
2.
3.
4.
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Perform steps 1 - 3 of IOEM and REM installation.
Open front panel - page 32 .
Install input device according to manufacturer’s specifications.
Feed aux device wires through drilled hole in rubber grommet to locations
G and H. Terminal strip is removable.
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CAUTION: Run high and low voltage cables through separate bulkhead and
conduit.
5.

6.

Installation and Wiring
A. Wire Digital input
Wire Aux Digital Input

Use (-) and (+) pin for selected input channels 1-4 for IOEM-4 and 1-8
for IOEM-8 to terminate wires. Terminate the ground wire to the (-) location. The 24V pin is used only when wiring a 4/20mA nonpowered device
that requires 24V loop power from the IOEM to power the 4/20 device.
Please see individual diagrams for wiring IOEM input devices:
A. digital device, page 45;
B. 0-1 and 0-5 volt device, page 45;
C. 4/20mA (powered/sink) and (not powered/source) devices, page 46;
D. temperature sensor instructions (no diagram provided), page 46

•
•
•
•
•

Install digital input device according to manufacturer’s instructions.
Use 2 wires to connect Digital input device to an IOEM channel.
Digital devices are mechanical and do not require power.
Connect switch wires to an IOEM I/O channel. There is no polarity for digital
input device wires; therefore, (+) and (-) terminals are interchangeable.
Configure 5X00 Eaux systems using AquaManager PC software. Complete
Eaux system configuration information is provided in the AquaManager
Help system.
Digital input switch

CAUTION: Inputs are not isolated. Devices connected must be electrically
isolated from ground and the water.
IOEM input and 4/20mA termination locations

CAUTION: Do not input external voltage.
B. Analog 0-1 and 0-5 Volt input

Wire Analog 0-1Volt and 0-5 Volt Input

•
•
•
•

Install 0-1 and/or 0-5 Volt analog device according to manufacturer’s instructions.
Use 2 wires to connect device to an IOEM channel.
Follow polarity from volt source to IOEM channel (+) to (+) and (-) to (-)see diagram below.
Configure 5X00 Eaux systems using AquaManager PC software. Complete
Eaux system configuration information is provided in the AquaManager
Help system.
Analog 0-1 Volt & 0-5 Volt device

7.
8.
9.

Complete wiring for all IOEM I/Os that will be used in application.
Close front panel - page 32.
Configure 5X00 E-Aux systems using AquaManager PC software.
Complete E-Aux system configuration information is provided in the
AquaManager Help system.
10. Test E-Aux/IOEM wired systems including display, control, and/or alarm
functionality based on the particular user-defined configuration.
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CAUTION: Observe correct polarity on analog input.
IOEM/REM Safey and Installation Guide
45

Installation and Wiring

Installation and Wiring

C. Analog 4/20mA source (not powered) and sink (powered) inputs

CAUTION: Run high and low voltage cables through separate bulkhead and

Wire 4/20mA source and sink inputs

•
•
•
•

conduit.

Install 4/20mA analog device according to manufacturer’s instructions.
Use diagrams below to connect device to IOEM channel.
Follow polarity from 4/20mA to IOEM channel as shown in the diagrams
below.
Configure 5X00 E-Aux systems using AquaManager PC software. Complete
E-Aux system configuration information is provided in the AquaManager
Help system.
Analog 4/20mA source input device

5.

Terminate temperature sensor wires to selected IOEM channel. There is
no polarity for temperature sensor wires; therefore, (+) and (-) terminals
are interchangeable. Make sure temperature sensor wires are terminated at
the (+) and (-) terminals for the particular Eaux channel being configuring.
Complete wiring to all IOEM I/Os that will be used in application.
Close front panel - page 32.
Configure 5X00 E-Aux systems using AquaManager PC software.
Complete E-Aux system configuration information is provided in the
AquaManager Help system.
Test E-Aux/IOEM wired systems including display, control, and/or alarm
functionality based on the particular user-defined configuration.

6.
7.
8.

Analog 4/20mA sink input device

9.

Directions to wire 4/20mA Outputs
5X00 instrument systems including pH, DO, temperature, conductivity, ORP, E-Aux
and aux can be configured to output a 4/20mA signal that can then be connected
to a non powered device, like a PLC, allowing use of the 4/20mA signal by other
programs. See the diagram below to wire a 4/20mA output
CAUTION: Observe correct polarity as shown in diagram.
WARNING: Disconnect external power to the unit before wiring.

Directions to wire temperature inputs
Any 5X00 instrument E-Aux system can be configured as a temperature input.
Temperature sensors for these systems have 2 wires and are terminated at location
G and H for IOEM-8 and at location G for IOEM-4. Temperature sensor(s) must
be thermistors with 10K at 25˚C, see Appendix 4 Alpha A Curve - page 91.

AVERTISSEMENT : déconnectez l’alimentation externe de l’unité avant d’effectuer
un câblage quelconque.
1.
2.
3.

Perform steps 1 - 3 of IOEM and REM installation.
Open front panel - page 32 .
Feed 4/20mA output wires through drilled hole in rubber grommet to
location G and H for IOEM-8 and at location G for IOEM-4. Terminal
strip is removable.

WARNING: Disconnect external power to the unit before wiring.
AVERTISSEMENT : déconnectez l’alimentation externe de l’unité avant d’effectuer
un câblage quelconque.

CAUTION: Run high and low voltage cables through separate bulkhead and
conduit.

1.
2.
3.
4.

Perform steps 1 - 3 of IOEM and REM installation.
Install temperature probe(s), see 5400 and 5500 user manual for probe
installation information;
Open front panel - page 32.
Feed temperature probe cable through drilled hole in rubber grommet
to location G and H for IOEM-8 and at location G for IOEM-4. The
terminal strip is removable.
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4.

Use (+) and (-) pins for wire terminations that will relay 5X00 system
4/20mA signal to external device, such as a PLC-see diagram below.

note:
-

4/20mA outputs can only source current, 4/20mA outputs cannot
sink current.
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B. 4/20mA Analog output

Wire 4/20mA 5X00 instrument Analog output

Installation and Wiring
Notes:
-

4/20mA output device

-

*Use an RS485 Line Extender/Booster for distances over 4000’ (1220m).
Communication failures may occur without it. Mount the booster in an
area where it is protected from moisture.
Network traffic speed operates at ~ 230 KB and is not user selectable.
Remove network terminal strip from any networked slave that is not
powered. Network rewiring is required if a stub (**see next note) is
created when a slave is taken off the network. See valid network configuration - figure 3.12, page 54

Note:
-

CAUTION: Observe correct polarity on analog output.

**A stub is created when the last wired network terminal strip is not
connected to a network slave - figure 3.9.

Network wire stub
A stub is created when the last wired network terminal strip is not connected to a network slave.

5.
6.
7.

8.

Complete wiring to all IOEM I/Os that will be used in application.
Close front panel - page 32.
Configure 5X00 system using AquaManager PC software as 4/20mA
output. Complete E-Aux system configuration information is provided
in the AquaManager Help system.
Test E-Aux/IOEM 4/20mA signal output at PLC device.

this is a stub

master

slave

master

slave

slave

slave

slave

slave

slave

slave

Step 6 Wire Network

this is not a stub

Multiple IOEM and REM, 5400 and 5500D-01, 5500D-02, 5500D-04 instruments
are networked using the RS485 network port. A node network consists of one master
and up to 31 slaves. The master can never be an IOEM or REM instrument. On a
network, the master is the point of access for the AquaManager PC software program.
RS485 network wiring can span distances up to 4000 feet (1220m). This maximum
distance (4000 ft) is for the total network distance, not the distance between networked units (*see Notes below). RS485 ports are optically isolated for safety, to
reduce noise, and to help eliminate ground loops. No further isolation is required.
Network traffic refers to the constant communication between the master and all
slaves on the network. For example, if a slave 5200A pH system is configured to
have a slave REM relay 4 dose up when in control range, and the 5200A is in pH
control range. The 5200A slave delivers this information to the master and the master
relays this information to the REM over the RS485 network and relay 4 is energized.
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(wired terminal
strip is not physically
connected to last
physical slave on
network)

(wired terminal
strip is physically
connected to last
physical slave on
network)

-represents wired network termination strip
-terminal strips located within master/slave image represent terminal strips that are physically
connected to device
-terminal strips that appear outside slave image represent terminal strips not connected to device

Figure 3.9

Directions to Wire Network
Network wiring consists of two pairs of twisted pair cable plus a communications
common wire. Category 5 ethernet cable is recommended. Network wires are terminated at location C IOEM and D REM.
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Installation and Wiring
WARNING: Disconnect external power to the unit before wiring.

REM network

AVERTISSEMENT : déconnectez l’alimentation externe de l’unité avant d’effectuer
un câblage quelconque.
1.
2.
3.
4.

Perform steps 1 - 4 of IOEM and REM installation.
Open front panel -page 32.
Strip five wires to terminate at network termination strip. Use appropriate
wire stripper to avoid wire nicks.
Feed networking cable through drilled hole in rubber grommet and to
location C IOEM and D REM. Terminal strip is removable.

Note:
-

It is essential that wires be terminated cleanly. Nicks (stray wires, not
cleanly terminated) can result in unreliable network communication.

CAUTION: Run high and low voltage wires/cables through separate bulkhead and conduit.
IOEM network

5.
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Terminate wires as described using category 5 cable: (color scheme may
be different than described below.)
- Pair #1 wires: solid blue and white with blue stripe
- Pair #2 wires: solid orange and white with orange stripe
- 1 wire green
- Secure unused wires to avoid potential for shorting

Wire the master as follows:
Wire Color
solid orange
white with orange stripe
solid blue
white with blue stripe
green

Terminal
T (-)
T (+)
R (-)
R (+)
Communications Common (C)

Wire all slaves as follows:
Wire Color
solid blue
white with blue stripe
solid orange
white with orange stripe
green

Terminal
T (-)
T (+)
R (-)
R (+)
Communications Common (C)
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Figure 3.10 is a wiring diagram for the most common IOEM and REM network
configuration where a master 5X00 instrument is the first physical device in the
network.

Installation and Wiring

Testing network configurations
Follow wiring instructions below to avoid testing network wiring with stubs.
Use below network wiring testing method when master is first physical device on network.
-represents wired network termination strip
-terminal strips that appear within master/slave box represent terminal strips that are physically
connected to device
-terminal strips that appear outside slave box represent terminal strips not connected to device

master

slave

1

slave

2

slave

3

slave

4

When master is first physical device on network, as shown above, connect terminal strip to master and last
slave (slave 4) to begin network testing. Terminal strips for slaves located between the master and the last
slave are then connected, one, by one beginning with slave device furthest from master and continuing to
slave devices closest to master. Testing in the above graphic would occur first with slave 4, then slave 3,
then slave 2, ending with slave 1.

Use below network wiring testing method when master is not first physical device on network.

Figure 3.10
6.

7.

Wire all network terminal strips prior to network testing, but only connect a network terminal strip to the first and last devices on the network
(*see note below). Network testing cannot be done if stubs exist (** see
note below).
Configure dip switches for all IOEM and REM slave instruments on the
network. See configure dip switches for slaves - page 55.

Notes:
-

-

For testing - If the master is not the first physical device on the network,
place network terminal strip on the master and on the first and last physical
devices on the network. (In this case two slaves will need to be tested at
the same time.) - figure 3.11 on next page .
The network must not include any stubs. **A stub is created when the
last wired network terminal strip is not connected to a network slave figure 3.9 - page 49.
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-represents wired network termination strip
-terminal strips that appear within master/slave box represent terminal strips that are physically
connected to device
-terminal strips that appear outside slave box represent terminal strips not connected to device

slave

slave

1

2

master

slave

3

slave

4

When master is not the first physical device on network, as shown above, connect terminal strip to master
and outer most slaves (slaves 1 and 4) to begin network testing. Testing in above graphic would occur first
with slaves 1 and 4, and then continuing by testing slave device 2, or slave device 3 until all network
wiring is tested.

Figure 3.11

IOEM and REM networks must be configured point-to-point (instrument-to-instrument). Network wiring cannot contain loops, stars, or stubs - figure 3.12, page 54.
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Configure dip switches for slave devices

Network configurations

Dip switches are used to set the network slave address. Dip switches are set at D
IOEM E REM locations

b
b

IOEM dip switch location
Master

slave

slave

slave

slave

slave

slave

Master

slave

slave

good

good

follow master/slave wiring directions figure 3.26

slave

slave

Master

slave

Master

slave

slave

slave

slave

slave

slave

bad
do not wire “star” network

slave

slave

bad
do not wire “loop” network

Figure 3.12
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Installation and Wiring
REM dip switch location

8.

Configure dip switch at D IOEM E REM to set slave addresses and termination switch. Use a small flat head screw driver to set the dip switches.
A. The first 6 locations set the slave address bit. Use binary notation to set
the dip switch slave address. Binary notation means switch 1=1, switch
2=2, switch 3=4, switch 4=8 and switch 5=16. (Dip switches 6 and 7 are
not used.) Due to the orientation of the dip switch component on the
board, number “1” is the far right switch. “On” is when the dip switch
is in the up position when viewing with front panel open as shown on
wiring diagrams throughout this user’s manual. Examples of 1-31 slave
address settings and termination are below.
B. Dip switch 8 (far left) is the network termination switch. Set dip switch
location 8 “on/up” when IOEM/REM device is the last slave on the network. Set dip switch 8 to “off/down” when IOEM/REM device is not the
last slave on the network.

slave address 4/termination on

slave address 5/termination off

slave address 6/termination on

slave address 7/termination on

slave address 8/termination off

slave address 9/termination on

slave address 10/termination on

slave address 11/termination off

slave address 12/termination on

slave address 13/termination on

slave address 14/termination off

slave address 15/termination on

slave address 16/termination on

slave address 17/termination off

slave address 18/termination on

slave address 19/termination on

slave address 20/termination off

slave address 21/termination on

slave address 22/termination on

slave address 23/termination off

slave address 24/termination on

Dip Switch configuration table for slave addresses (1-31) and network termination
slave address 1/termination on

slave address 2/termination off

slave address 3/termination on
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slave address 25/termination on

slave address 26/termination off

slave address 27/termination on

Installation and Wiring

RS232 Communication
Use Category 5e patch cable from RS232 port at location E IOEM and F REM
RS232 Communication. Use an RJ45 to DB9 adapter to connect cable to PC 9 pin
com port.

slave 28/termination on

slave 29/termination off

slave 30/termination on

IOEM com port

slave 31/termination on

9. Close front panel - page 32.
10. Test network connections. Apply power to only the master and last slave
device on the network. If the master is not the first physical device on the
network, apply power to the master and the first and last physical slave
devices on the network See configure network menu in 5X00 user manuals
for testing procedure. Slave devices need to be tested one by one as they
are added to the network.

Step 7 Connect Communication Cable for Firmware
Update

REM com port

An RS232 communication cable must be connected locally at the expansion module
to a PC running AquaManager in order to upload new IOEM and REM firmware.
Firmware is uploaded to IOEM and REM instruments using AquaManager. See
Updating Instrument Firmware at AquaManager help or follow the steps below to
upload new IOEM/REM firmware.
Note:
-

When making RS232 cable runs greater than 100 feet (30.5 m), use an
RS232 Line Extender/Booster. Mount the booster in an area where it is
protected from moisture.

IOEM/REM Safey and Installation Guide
58

IOEM/REM Safey and Installation Guide
59

Installation and Wiring

Installation and Wiring

Directions to Wire Direct PC Connection for firmware update

Like all microprocessor based instruments, it may be necessary to upload firmware
revisions to IOEM/REM instruments. Download new firmware using the Firmware
Updater utility in AquaManager. A serial RS232 connection is necessary to run the
Flash Programmer utility.
WARNING: Disconnect external power to the unit before wiring.
AVERTISSEMENT : déconnectez l’alimentation externe de l’unité avant
d’effectuer un câblage quelconque.
1.

Perform steps 1- 6 of IOEM and REM installation as required for the
application;
2. Open front panel - page 32;
3. With front panel open connect RS232 direct connect cable to location E
IOEM and F REM. RS232 cable is disconnected after firmware update,
so with wiring removed, after firmware update, RS232 communication
cable does not interfer with front panel closure.
Notes:
- When using a USB-Serial Adapter, verify that the port number assigned
during driver installation is the same port configured at AquaManager
Firmware Updater utility.
- Use only a Tripp-Lite Keyspan USB-Serial Adapter, model USA-19HS
YSI p/n 773 (64-bit).
- The instrument firmware may get corrupted if any of the following occurs
during a firmware update: a) Firmware Updater window utility is closed,
b) AquaManager is closed c) RS232 cable is removed from IOEM/REM
or PC com port, d) power is disconnected from IOEM/REM. If IOEM/
REM firmware becomes corrupt and is not updated properly, it may be
necessary to return the instrument to YSI.
4. Confirm latest version of AquaManager is installed on PC - page 81.
When an AquaManager patch has been installed and if new firmware is
available, a “Firmware Update is Available” message is displayed when
the IOEM/REM Systems Management expanded window is open at
AquaManager.
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5.

Upload new firmware using AquaManager. From the AquaManager Explorer window, access the Flash Programmer utility from AquaManager
pull down menu: Tools→ Instrument tools→Update Firmware. Firmware
updater window opens.

6.

At Firmware Updater window File>Load Firmware Database default database firmware folder opens. Select latest firmware .mdb file to be uploaded
to instrument(s). Once selected, Database file is displayed at File window.
Notes:
- Firmware Database file contains latest 5X00 and IOEM/REM instrument
firmware. 5X00 and IOEM/REM instruments automatically upload proper
firmware for specific instrument type;
- YSI .mdb firmware files are located in Program Files (folder where
AquaManager is installed on user PC)>AquaManager>Firmware folder.
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-

The same .mdb file is used for all 5X00 and IOEM/REM instruments.
Once the upload process begins the instrument type is determined and
the appropriate firmware is uploaded.

7.

Installation and Wiring
8.

Left click “Yes” to begin firmware upload. Firmware Updater screen opens;

at Firmware Updater window. Firmware Update info window
opens;

9.

at
window when upload
completes;
10. Verify uploaded version information is correct at IOEM/REM node after
manually polling IOEM/REM instruments. When all instruments have
been uploaded with new firmware, it is important to open and poll all nodes
to ensure latest firmware version is stored at AquaManager database. After
manual poll, it may be necessary to close node window at AquaManager and
reopen in order for latest firmware version to be displayed at node window.
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“Unit is Up-To-Date” indicates that the expansion module has most recent firmware
and upload is not necessary.

11. Remove RS232 communication cable.
12. Close front panel - page 32.

Notes:
-

-

During upload, any active IOEM/REM devices are placed into Service
Hold which de-energizes any active systems including energized relays.
See SVR Hold Menu in 5X00 user’s manuals for additional information .
No “off” event is created for IOEM/REM channels that are placed in
Service Hold during firmware update process.
Systems are reset when power is cycled after downloader;
IOEM/REM total download time is < 1 minutes. IOEM/REM module
will automatically reboot at firmware upload completion;
Autopoll must be shut down when firmware is uploaded to 5X00;
All logs and unit configuration are retained when 5X00 firmware is
updated.
Firmware Updater information is also included in AquaManager
Help>Firmware Updater>Updating Instrument Firmware topic page.

Flash Programmer Updater Messages
The Firmware Updater program may respond with one of the following messages
to indicate that the upload did not occur.
“Timed out” or “Could not find Unit” messages usually indicate a communication
problem between PC and expansion module. Reconfirm AquaManager Firmware
Updater com port setting and RS232 connections. Power cycle the instrument,
close and reopen AquaManager and perform upload firmware steps again to see if
communication problem is resolved.
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Lightning and Surge Protection
AC line voltage surge suppressors protect field equipment on any AC line-to-ground
from damage due to electrical transients induced in the interconnecting power lines
from lightning discharges and other high voltage surges. Surge protection devices
are strongly recommended to protect your equipment from secondary surges and
lightning on outdoor installations. Follow the recommendations provided when
choosing and incorporating surge protection devices into your operation:
Recommendations:
•
•
•
•
•
•

Surge suppression devices should be located on the AC line supplying
power to the IOEM and REM and any signal lines connecting the IOEM
and REM.
The unit should include noise filtering, common mode, and normal mode
suppression and nanosecond reaction time.
Surge suppressors should be internally-fused to remove the load if the
unit is overloaded or the internal protection fails.
Signal line suppressors protect low voltage signals and relay outputs
from damage due to electrical transients induced in the signal lines from
lightning discharges or nearby electrical devices.
Signal line suppressors should be installed at each end of an analog loop.
Relay outputs should be protected at the receiver end.

IOEM/REM Safey and Installation Guide
65

Installation and Wiring

•
•
•

Signal line suppressors should consist of a three-element gas tube followed
by metal oxide varistors and suppressor diodes.
The protective elements should be matched such that high-energy surge
voltages trigger the gas surge arrester, while low energy or surge voltages
affect the MOV’s and suppressor diodes.
Lightning protection devices should be located as close to the IOEM and
REM as possible and wired in accordance with the National Electric Code
in approved watertight enclosures.

Installation and Wiring
ATTENTION : les modèles d’IOEM (module d’expansion d’entré et de sortie)
et de REM (module d’expansion de relais) utilisent des appareils transistorisés
sensibles pouvant être endommagés par des décharges d’électricité statique.
Les installateurs doivent observer les procédures de protection acceptées contre
les décharges électrostatiques lors du câblage à la carte de l’IOEM et du REM.

CAUTION: This or any other installation procedure cannot protect against a
direct lightning strike. YSI Incorporated cannot accept liability for damage
due to lightning or secondary surges.

Sealants, Desiccants, and Securing IOEM and REM
Environmental conditions can promote the formation of condensation in and around
the IOEM and REM. It is very important to follow the steps below to prevent damage
to the electronic components and to extend the life of the IOEM and REM system.
1.
2.

3.

4.
5.
6.

Place solid rubber grommets in bulkhead fittings that have no electrical
connections.
If using optional conduit fittings (YSI p/n 065926UL) in place of bulkhead
fittings, industrial encapsulant (YSI p/n 065921 conduit sealer) must be
used to prevent moisture from entering the IOEM and REM enclosure.
Apply the sealant after all wiring and connections are complete. Failure
to use industrial encapsulant may result in damage to the IOEM and REM.
Desiccant pack must be replaced whenever the IOEM and REM enclosure
is opened (Desiccant pack, YSI p/n 006506). Desiccant absorbs moisture
captured within the enclosure.
Ensure that the rubber gasket is seated between front panel and enclosure
whenever enclosure is closed.
Replace the front panel ensuring that the ribbon cable is not trapped in
the gasket channel before inserting mounting screws.
Tighten mounting screws, making sure not to cross thread. The screws are
stainless steel and the receiving threads are brass. Do not over-tighten!
CAUTION: The IOEM and REM utilizes sensitive solid state devices that can
be damaged by static shock. Installers must observe accepted ESD (ElectroStatic Discharge) procedures while connecting wires to the IOEM and REM
control board.
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Using AquaManager to configure IOEM
and REM Channels

Configuring IOEM/REM expansion modules

IOEM and REM Configuration and Monitoring
IOEM and REM expansion modules do not have a user interface, meaning no
configuration other than hardware wiring (page 43 IOEM and page 40 REM)
and slave address configuration (page 55) are done locally at expansion modules.
AquaManager is required to upload IOEM mode configuration to the instrument. In addition, AquaManager must be used to upload all sensor setup>sensor
system>output 4/20mA menus which menus include configuration of IOEM
slave and channel to be used for a sensor system output. AquaManager includes
software checks that help to validate IOEM 4/20mA output assignment configuration. Directions to configure these menus using AquaManager are provided at
the Quick Start - IOEM Configuration starting on page 72.
At AquaManager polls, a network query occurs to determine whether configuration changes have been made to any networked instruments. When configuration
changes are detected during an AquaManager manual poll, AquaManager updates
the database to ensure the AquaManager database is in sync with networked instruments. Example - if a manual poll is performed on a networked master 5200A, all
instruments on the network are queried. If, on this network, a change was made
locally to a slave 5500OD, the local change made to the slave 5500OD is updated to
AquaManager. This process allows the database to be up to date with the instruments
at all times. It is critical that the instruments be polled at frequent time intervals to ensure AquaManager is in sync with actual instrument configuration.
Note:
-

Manual polls are required to update AquaManager firmware updates. Autopolls do not update firmware installation version information. See verify
latest firmware version after using Firmware Updater - step 10, page 63

Quick start guide instructions are provided for IOEM I/O - page 72 and REM
- page 80.
Use 5X00 instrument user manuals for information regarding Run Screen, Sensor and System set up menu configuration. To Access pdf interactive manuals in
AquaManager at the Explorer Window Help>Instrument Manuals>scroll and select instrument manual to open interactive pdf file. Configuration of IOEM input,
4/20mA, PID control output and REM relay system configuration are provided at
sensor setup section in chapter 4 of 5X00 user manuals. Configuration of System
Menu items (such as general alarm relay) are provided at system menu>appropriate
system section in chapter 4. Configuration of Timer relays are provided at Timers
Menu section in chapter 4. Manuals are also accessible at http://ysi.com/resourcelibrary.php.
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IOEM/REM terminology
Below is a list of common terminology used to describe IOEM and REM devices
as well as IOEM, REM and 5X00 Eaux system functionality:
I/O-An IOEM instrument is an I/O device whose channels are wired and configured
using the IOEM expansion module. “I”= input. Configure an IOEM channel to be an
input when the incoming signal is used to track a temperature, 0-1v, 0-5v, 4/20mA,
or digital device. “O” = output. Configure an IOEM channel to be a 4/20mA output
when a 5X00 system input signal is to be converted to a 4/20mA output signal which
can be used by another connected device such as a PLC. 4mA-20mA outputs can
also be used as a 5X00 system PID control device.
Channel-refers to the physical 1 through 4 (IOEM4) and 1 through 8 (IOEM8) I/
Os. I/O devices are wired to terminal strips located on the IOEM expansion module
see page 43; Channel also refers to the physical 1 through 4 relay outputs wired
to terminal strip locations 1-4 on the REM expansion module - page 40.
E-Aux Systems-5X00 instruments have eight (8) E-Aux systems. E-Aux systems
are configured to monitor, control and/or alarm IOEM inputs the same way 5X00
sensor systems function. E-Aux systems have data and event logging functionality.
E-Aux systems are also referred to as “virtual systems.”
E-Aux system datalogs-5X00 E-Aux system datalogs are not visible at the instrument. AquaManager datalogs must be used to view E-Aux system datalogs;
Local vs Remote Instruments-A local instrument on a 5X00 network is defined
as a 5X00 instrument that is using it’s own relay output as a sensor or system control or alarm. So, for example if a 5200A’s (s/n 53-1111111) pH control or alarm
system is configured to use it’s own (5200A s/n 53-1111111) relay 1 to control for
low pH, the relay assignment is considerated a local relay configuration. If this
same 5200A’s (s/n 53-1111111) pH control or alarm system is configured to use a
networked 5500 (s/n 55-2222222) relay 1, the relay configuration is considered a
remote relay configuration. IOEM input and IOEM and REM output channels are
always considered to be remote configurations because expansion modules input
and output devices are always configured to a networked 5X00 instrument system.
Knowing the difference between local and remote instruments is important since
certain menus like 5X00 system and sensor setup menus display local versus remote
instrument names differently.
Instrument and Relay name conventions at 5X00 instrument menus - Configured
instrument and relay names are displayed differently at a 5X00 instrument when
local versus remote instruments are selected at configuration menus. For example,
at sensor setup>sensor selection>control/alarm system>Instrument window, the
instrument window displays a generic list of instruments being Local Machine,
Master and Slaves 1-31. The Local Machine user configured name is displayed if the
local machine is configured. A relay is selected at the sensor or system>relay menu.

IOEM/REM Safey and Installation Guide
71

Configuring IOEM/REM expansion modules

Configuring IOEM/REM expansion modules
The relay window displays a generic list of relays being relays 1-8 regardless if a local relay has a user configured name. Remote 5200A or REM instruments always
display relays 1-8 even though these instruments have only 4 relays.
Mode-refers to the input or output configuration of an IOEM channel. Selectable Input modes are: digital, 0-1V, 0-5 V, 4/20mA and temperature. There is one
output mode and it is 4/20mA. IOEM channel mode can only be configured
using AquaManager. IOEM modes are configured in AquaManager at the IOEM
node>Systems Management>Channel Mode pulldown menu;
5X00 systems-refers to any 5X00 sensor system. 5200A systems are pH, ORP,
conductitivity , temperature, DO, Aux and E-Aux. 5400 and 5500 sensor systems
are DO, Aux and E-Aux.
Source-refers to the IOEM device slave address and channel number that a particular
Eaux system will use as its input. The IOEM source is configured in AquaManager
at the E-Aux 1-8 tabs. IOEM inputs can be used by multiple E-Aux systems.
Virtual system-5X00 E-Aux systems are referred to as virtual systems because of
their ability to be used for a variety of device configurations.
AquaManager provides data logging, graphing, autopolling, mapping and system
configuration uploading functionality. AquaManager also displays near real-time
sensor, aux and E-Aux input values at the desktop PC. AquaManager is a valuable
tool for remote and local access applications.
Use AquaManager to configure IOEM and REM system menus. After polling all
instruments on a network, use node window “Systems Management” to view and
upload IOEM and REM configurations.
Detailed AquaManager user information is included in the AquaManager Help
system.

function. Eaux systems also have datalogging and event logging functionality.
2) 4/20mA output mode - IOEM channels can be configured as a 4/20mA output.
The 4/20mA output can be used for any 5X00 sensor (pH, ORP, conductivity, temperature, DO), aux and eaux (analog, digital, temperature) system. The 4/20mA
output signal can be used by another connected device such as a PLC.
3) PID control output device mode - 4/20mA IOEM output channels can be configured for a PID control output device for 5X00 sensor (pH, ORP, conductivity,
temperature, DO) and aux and eaux non digital systems. PID control devices, such as
a valve, would open and close at user configured setpoints to maintain system values.
Notes:
-

Configuration of the IOEM mode is done at the IOEM node>Systems Management window>Channel Mode pulldown menu. Full configuration directions and
functionality are provided in AquaManager help.

Use AquaManager to configure IOEM channel mode
1.
2.

3.
4.
5.

The IOEM and REM Quick Starts guides below assumes a user has a general
knowledge of AquaManager Explorer and Systems Management Windows.

Quick Start - IOEM Configuration

IOEM instruments have either 4 I/O channels (IOEM-4) or 8 I/O channels (IOEM-8).
IOEM channels can be configured one of three (3) modes. Each mode is described
below:
1) Input mode - IOEM channels can be configured as an input. Input mode selections
are digital, 0-1Volt, 0-5Volt, 4/20mA and temperature. IOEM inputs use one of the
5X00 instrument’s eaux systems. (Each 5X00 instrument has 8 Eaux systems. Eaux
systems are also referred to as virtual systems.) 5X00 Eaux systems are configured
to monitor, control and/or alarm IOEM inputs the same way 5X00 sensor systems
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IOEM mode must be configured using AquaManager.
5X00 system must be configured in the PID 4/20mA control mode for
PID control output device mode option to be available.

Verify latest AquaManager version is installed - page 81;
Build AquaManager Network. At AquaManager Help>Contents tab>
Working with nodes>Communication>Insert Node with direct connection or Insert Node with IP connection>Insert Slave device help topic
bookmark for information.
for all networked nodes including IOEM node(s).
Verify latest IOEM/REM firmware is installed - page 60;
Configure IOEM I/O mode at the IOEM node systems management window. At AquaManager Help>Contents tab>Working with
nodes>Expansion modules>IOEM>Configure IOEM mode help topic
bookmark for information.
. to upload IOEM I/O channel mode configuration to

6.
network.
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IOEM systems management window mode pulldown menu

Configuring IOEM/REM expansion modules
8.

At the Run Screen verify the configured E-Aux value is properly displayed.
E-Aux system scaling and min/max configuration affect the displayed
value.

5X00 Systems Management Eaux tab non PID control mode

Configure 5X00 E-Aux system for IOEM input
1.
2.
3.

Follow steps 1-6 of hardware installation-starting on page 25;
Wire IOEM I/O for desired input type- page 43;
Verify all steps at Using AquaManager for IOEM configuration - page
73 are completed

;
4. Open AquaManager>open 5X00 node window>
5. Select E-Aux 1-8 tab to be configured.
6. Configure E-Aux system fields;
Notes:
- IOEM Source channels are only available once IOEM mode has been
uploaded using AquaManager-page 73;
- IOEM Sources will only be available at IOEM and channel mode pulldown menus that have been configured as the same input type as the
“IOEM Desired Selection” field for the E-Aux system being configured;
- Proper wiring of IOEM I/O channels is required in order for IOEM I/O
channels to work correctly.
- For 5X00 E-Aux configuration information see - AquaManager
Help>Contents tab>Working with Nodes>Systems management>Systems
Management fields table and link to E-Aux bookmarks;

Notes:
-

IOEM input channels can be configured to multiple E-Aux systems;
At the Run Screen “Offline” display means the configured IOEM I/O
input/output is a value that the associated 5X00 instrument E-Aux
system does not recognize. An example - if an IOEM channel mode is
configured to digital and the input signal is a 0-1V signal, the reading at
the run screen will be “Offline”;

5X00 instrument run screen when IOEM input value is invalid

to upload E-Aux system configuration to networked in-

7.
struments;

-
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At the instrument, the IOEM source is configured at the System>EAux>Device Address and Channel menus. See user manual sensor setup
sections, chapter 4 for additional information;
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Configuring IOEM/REM expansion modules
Configure 5X00 system for IOEM 4/20mA output

-

1.
2.
3.

Follow steps 1-6 of hardware installation-starting on page 25;
Wire IOEM I/O for 4/20 output type- page 47;
Verify all steps at Using AquaManager for IOEM configuration - page
73 are completed;

4.
5.
6.

Open AquaManager>open 5X00 node window>
Select 5X00 system tab to be configured;
Configure 5X00 4/20mA output system fields;

-

;

4/20mA output channels can only be assigned to 1 5X00 system at a
time. When selecting a 4/20mA output channel that is currently pending
or confirmed AquaManager displays the below 4/20mA Conflict Error
will not be live until the 4/20mA assignment
window.
conflict is resolved
4/20mA output values cannot be viewed at 5X00 instruments or at
AquaManager.

5X00 Systems Management PID control mode with 4/20mA output configuration

7.
8.

9.

to upload system configuration to networked instrument;
Test configured output functionality after reconfiguring - see Chapter 4
5X00 instrument manuals Configuring>Sensor Setup>Service> Output test
system menu to verify 4/20mA output.
Verify 4/20mA signal. The 4/20mA output signal is not displayed at the
Run Screen. Therefore, it is strongly recommended to verify the 4/20mA
signal at the IOEM or third party device.

Configure 5X00 system for IOEM PID output control device

Notes:
-

must be selected to make 4/20mA fields live;
Proper wiring of IOEM output channel is required in order for IOEM
4/20mA output device to work correctly.
IOEM Source channels are only available at 5X00 system fields once
IOEM mode has been uploaded using AquaManager-page 73;
IOEM Sources will only be available at IOEM and channel mode pulldown menus that have been configured as a 4/20mA output type; For 5X00
system configuration field information see - AquaManager Help>Contents
tab>Working with Nodes>Systems management>Systems Management
fields table and link to specific sensor system being configured bookmarks;
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1.
2.
3.

Follow steps 1-6 of hardware installation-starting on page 25;
Wire IOEM I/O for 4mA-20mA output type- page 47;
Verify all steps at Using AquaManager for IOEM configuration - page
73 are completed;

4.
5.
6.

;
Open AquaManager>open 5X00 node window>
Select 5X00 system tab to be configured;
Configure 5X00 system fields
- For 5X00 system configuration field information see - AquaManager
Help>Contents tab>Working with Nodes>Systems management>Systems
Management fields table and link to specific sensor system being configured bookmarks;
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Configuring IOEM/REM expansion modules

5X00 Systems Management PID control mode with 4/20mA PID output control device

7.
8.

icon will be displayed at the Run Screen for systems configured
with a PID output control device.

to upload system configuration to networked instrument;
Verify wired 4/20mA output device is regulating the system correctly
based on the system value.

Reset IOEM to factory
Follow the steps below to reset an IOEM expansion module back to factory settings.
A factory reset will return all IOEM channels to the default mode of 0-1V input.
All 5X00 instrument systems that were configured using IOEM inputs and outputs
need to be reconfigured. Reset of IOEM to factory also restores IOEM instrument
and channel names to default names.
Notes:
-

-

Proper wiring of IOEM output channel is required in order for IOEM
4ma-20mA output control device to work correctly.
IOEM Source channels are only available at 5X00 system fields once
IOEM mode has been uploaded using AquaManager-page 73;
IOEM Sources will only be available at IOEM and channel mode pulldown menus that have been configured as a 4/20mA output type;
For 5X00 system configuration field information see - AquaManager
Help>Contents tab>Working with Nodes>Systems management>Systems
Management fields table and link to specific sensor system being configured bookmarks;
4/20mA output channels can only be assigned to 1 5X00 system at a
time. When selecting a 4/20mA output channel that is currently pending
or confirmed AquaManager displays the below 4/20mA Conflict Error
window.
conflict is resolved.

will not be live until the 4/20mA assignment
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1.
2.

3.
4.
5.
6.
7.

Open front panel - page 32;
Press Reset button for about 10 - 11 seconds. The reset button is located to
the left of the DC power connection (located at location A) on the metal
plate inside the enclosure. Observe that both status leds, as described at
page 85, display solid green at the same time before releasing the reset
button. Some clicking at board may be heard as all channels are reset to
0-1V inputs. Leds return to normal operation (page 85) several seconds
after reset.
Close front panel -page 32.
Manually poll all nodes at AquaManager to ensure the AquaManager
database is properly updated to reset configurations.
Reconfigure IOEM input/output modes - see page 73;
Reconfigure 5X00 systems IOEM inputs and outputs after polling all
nodes at AquaManager;
Test configured input and output functionality after reconfiguring.
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Configuring IOEM/REM expansion modules

Quick Start - REM Configuration

An REM has 4 relay outputs. REM relays are available at all 5X00 instrument
menus including sensor, aux, E-Aux, Timer and system menus.

Use AquaManager to configure REM
1. Verify latest AquaManager version is installed - page 81;
2. Build AquaManager Network;
Note:
- At AquaManager Help>Contents tab> Working with nodes>Insert Node
with direct connection or Insert Node with IP connection>Insert Slave
device help topic bookmark for information.
for all networked nodes including REM node(s).
3.
4. Verify latest REM firmware is installed - page 60;
5. Configure REM node systems management window.
6.

5. Select 5X00 system tab to be configured;
6. Configure 5X00 system fields.
Notes:
- At AquaManager Help>Contents tab>Working with nodes>Expansion
modules>REM>Configure REM relay to a 5X00 system bookmark for
information;
7.
8.

to upload system configuration to networked instrument;
Test configured relay output functionality after reconfiguring - see Chapter
4 5X00 instrument manuals Configuring>Sensor Setup>Service> Output
test system menu to verify 4/20mA output.

Notes:
-

. to upload REM configuration to AquaManager network.

At Run Screen 5X00 instrument system using REM relay will show control
and or alarm relay icons when REM system relay is energized;
REM relay events are stored at the 5X00 instrument using the relay;
REM channels can be assigned to multiple system;

REM systems management window

Reset REM to factory
Follow the steps below to reset an REM expansion board back to factory settings.
A factory reset will return all REM channels to the default instrument and channel
names. It is important that AquaManager poll all nodes after any instrument on a
network is reset to factory.
1.
2.

3.
4.
5.
6.

Configure REM relay(s) to 5X00 system(s)
1.
2.
3.

Follow steps 1-6 of hardware installation-starting on page 25;
Wire REM relays - page 40;
Verify all steps at Use AquaManager to configure REM - page 80 are
completed;

4.

Open AquaManager>open 5X00 node window>
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;

Open front panel - page 32
Press Reset button for about 10 seconds. The reset button located to the
left of the DC power connection (located at location A) on the metal plate
inside the enclosure. Observe that both status leds, as described at page
85, display solid green at the same time before releasing the reset button
Close front panel -page 32.
Poll all nodes at AquaManager to ensure the AquaManager database is
properly updated to reset configurations.
Reconfigure 5X00 system REM outputs after polling all nodes at AquaManager.
Test configured output functionality after reconfiguring.

Confirm latest AquaManager version is installed on PC
For proper AquaManager functionality it is important that the latest AquaManager version be installed on your PC. Comprehensive information is provided in
AquaManager Help>Contents tab>Getting Started>System Requirements>Update
AquaManager Software for version information.
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Configuring IOEM/REM expansion modules
If an AquaManager patch is available the user will be notified at AquaManager program launch. Because many AquaManager users run Autopoll 24/7 a new feature
has been added to AquaManager to ensure the current AquaManager version is
installed and running on the PC. A notification of any AquaManager patch update
is sent every 30 days regardless of AquaManager program launch. This notification
will be visible, if after 30 days, a new AquaManger version is available regardless of
what AquaManager window is open.
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Unpacking and Inspection

Appendix 1 Unpacking and Inspection
Inspect the outside of the shipping carton for damage. If damage is detected, contact
the carrier immediately. Remove the instrument from the shipping container. Be
careful not to discard any parts or supplies. Confirm that all items on the packing list
are present. Inspect all assemblies and components for damage. Save the original
packing carton. Carriers typically require proof of damage due to mishandling.
The following components are included with the purchase of the IOEM and REM
instrument:
IOEM and REM instrument
006515 Flange Mounting Kit
006506 Desiccant Kit
605876 Instruction Manual
605230 Compression Plugs, 2 each
605229 Compression Plugs, 2 each
605804 Compression Plugs, 1 each
655384 Dual Male RJ-45 Cable Assembly
655383 Adapter, DB-9 to RJ-45
605880 AC Power Cord, 115 VAC U.S. Plug (AC version only)
605944UL Pluggable Socket Connector for AC power, 3 pole (AC Version only)
506939UL Pluggable Socket Connector for 12 VDC Power, 2 pole
605941UL Pluggable Socket Connector for RS-485, 5 pole
605943UL Pluggable Socket Connector for relay, 12 pole
605940UL Pluggable Socket Connector for Auxiliary inputs, 3 pole
If any parts are damaged or missing, contact YSI or your YSI representative immediately.
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Appendix 2 Troubleshooting
Status leds
There are 2 status leds located on IOEM and REM devices. The leds are located left
of the DC power connector location at A on IOEM and REM devices
The PWR status LED is illuminated solid green when 12v power is applied. The COM
status LED has 3 states as described below:

1.

2.
3.

OK (RS485 communications active)
A. Short (100mS) flash every second. This is the normal and most common
state.
Communication error
A. Fast blinking (on 200mS/off 200mS)
Bootloader, when firmware is being uploaded
A. Slow blinking (on 500mS/off 500mS)

See IOEM reset to factory - page
See REM reset to factory - page

Relay (Outputs) Troubleshooting
-

Disable control, alarm, and timer relays when troubleshooting relay
outputs.
Verify IOEM and REM wiring and configuration.

Issue

possible cause

possible solution

relay does not energize

incorrect sensor configuration

See Set Points, Controls,
and Alarm, 5X00 instrument user manuals.
is correct relay configured?

incorrect timer configuration

See Timers, 5X00 instrument user manuals.

30 second delay at power up
and/or sensor configuration
change

See 30 seconds delay,
5X00 instrument user
manuals.

peripheral device is wired
incorrectly

See Wire Relays - page
40 and Test Relays - page
34.
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Issue

temp (high), pH, and or
conductivity relays do
not de-energize when set
point values are read

Troubleshooting

possible cause

possible solution

Issue

possible cause

possible solution

relays are not enabled for
control/alarm/timer system

Verify menu configuration- See Set Points,
Controls, and Alarm>relay
enable menus and
Timer System>relay enable
menus, 5X00 instrument
user manuals.

IOEM and REM does
not go into downloader
mode when “program
device” is selected at
Firmware Updater

incorrect wiring of RS232
connection

see “Status leds” on page
85 to confirm that expansion module is in downloader.

sensor is configured for
timed control

See Set Points, Controls,
and Alarm, 5X00 instrument user manuals.

unit does not upload new unit is not in downloader
code at downloader
mode

see “Status leds” on page
85 to confirm that expansion module is in downloader

AquaManager Troubleshooting

Network Troubleshooting

Refer to AquaManager online Help for all AquaManager operation and troubleshooting
information.

Issue

possible cause

possible solution

no communication to
networked unit(s)

Are master/slave menus
properly configured?

See Networking - page
48.

Is termination relay enabled
See Termination Relay in 1st & last IOEM and REM page 56.
on network?

slow network performance

Are slaves enabled and recognized at master?

See System → Communications → Network →Master
menu, 5X00 instrument
user manuals.

more than one device is
configured as a master

See System → Communications → Network →Master
menu, 5X00 instrument
user manuals.

nicked wires;
improper wiring

Verify network wiring See Wire Network - page
48.

Firmware Updater Troubleshooting
Issue

possible cause

possible solution

Device “timed out” error

incorrect wiring of RS232
connection

See Connect RS232 Communication Cable - page
58 .
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Declaration of Conformity

Appendix 3 Declaration
of Conformity
Conformity
Declaration of

Declaration of Conformity

Supplementary
Information:

All performance met the continuous
unmonitored operation criteria as follows:
• ESD, EN61000-4- :200
• Radiated Immunity, EN61000-43:2006+A1:2007
•.EFT, EN61000-4-4:2004
• Surge, EN61000-4-5:200
• Conducted Immunity, EN61000-4-6:200
• Voltage Interrupts, EN61000-4-11:2004 2nd edition

Authorized EU
Representative

YSI Hydrodata Ltd
Unit 8, Business Centre West, Avenue 1
Letchworth, Hertfordshire, SG6 2HB UK

The undersigned hereby declares on behalf of the named manufacturer under our sole
responsibility that the listed product conforms to the requirements for the listed European
Council Directive(s) and carries the CE mark accordingly.
Manufacturer:

YSI Incorporated
1725 Brannum Lane
Yellow Springs, OH 45387
USA
,

Product Name:

,

Model Numbers
Instrument/Accessory:
Conforms to the following:
Directives:

EMC 2004/108/EC
RoHS 2011/65/EU
WEEE 2002/96/EC
LVD 2006/95/EC

Harmonized Standards:

• EN61326-1:20 , Electrical equipment for
measurement, control, and laboratory use – EMC
requirements – Part 1: General Requirements
• EN61000-3-2:
Electromagnetic compatibility (EMC) – Part 3-2:
Limits – Limits for harmonic current emissions
(equipment input current < 16A per phase).
• EN61000-3-3:2008, Electromagnetic compatibility

Signed:
Title: Quality

Date:

The undersigned hereby declares on behalf of the named manufacturer under our
sole responsibility that the listed product conforms to the requirements for electrical
equipment under US FCC Part 15 and ICES-003 for unintentional radiators.
Manufacturer:

YSI Incorporated
1725 Brannum Lane
Yellow Springs, OH 45387
USA

(EMC) – Part 3-3: Limits – Limitation of voltage changes,
voltage fluctuations and flicker in public low-voltage
supply systems, for equipment with rated current < 16A
per phase and not subject to conditional connection..

Product Name:

• IEC61010-1:2010

Conforms to the following:

Model Numbers
Instrument/Accessory:
Standards:

• FCC 47 CFR Part 15, Radio Frequency Devices
• ICES-003:20 , Digital Apparatus

Signed:
Title: Quality
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Date:
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FCC Required Notice

FCC Required Notice

Alpha “A” curve

Appendix 4 Alpha “A” curve

The Federal Communications Commission defines this product as a computing
device and requires the following notice.
This equipment generates and uses radio frequency energy and if not installed and
used properly, may cause interference to radio and television reception. It has been
type tested and found to comply with the limits for a Class A or Class B computing
device in accordance with the specification in Subpart J of Part 15 of FCC Rules,
which are designed to provide reasonable protection against such interference in
a residential installation. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio
or television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or more of the
following measures:
-

Reorient the receiving antenna
Relocate the computer with respect to the receiver
Move the computer away from the receiver
Plug the computer into a different outlet so that the computer and
receiver are on different branch circuits.

If necessary, the user should consult the dealer or an experienced radio/television
technician for additional suggestions. The user may find the following booklet, prepared by the Federal Communications Commission, helpful: “How to Identify and
Resolve Radio-TV Interference Problems”. This booklet is available from the U.S.
Government Printing Office, Washington, D.C. 20402, Stock No.0004-000-00345-4.
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Parts & Accessories

Appendix 5 Parts and Accessories
Item #

Part Description

115250

BOARD,ASSY,IOEM-4,AQUACULTURE,SWI

115251

ELECTRONICS ASSY, IOEM-8,AQUACULTURE,SWI

115252

BOARD,ASSY,REM-4,AQUACULTURE,SWI

115253

STAINLESS STEEL LOCKING LATCH KIT, AQUACULTURE SWI

115254

COVER REPLACEMENT KIT, AQUACULTURE SWI

115255

COMPRESSION FITTING ASSEMBLY,3/8NPT,.16-.31,CABLE,RANGE
,AQUACULTURE,SWI

115256

COMPRESSION FITTING ASSEMBLY,1/2NPT,.24-.47CABLE,RANGE
,AQUACULTURE,SW

115257

COMPRESION FITTING ASSEMBLY,3/4NPT,.51-.71,CABLE,RANGE
,AQUACULTURE,SWI

115258

MOUNTING,FEET,KIT,PREMIUM,LINE,AQUACULTURE,SWI

Appendix 6 Warranty
YSI IOEM and REM instruments are warranted by YSI for two years from date of
purchase by the end user against defects in materials and workmanship (excluding
components and materials for YSI IOEM and REM devices which are separately
warranted below). All YSI cables, probe modules, and sensors for the YSI IOEM and
REM are warranted by YSI for one year from date of purchase by the end user against
defects in material and workmanship. Within the applicable warranty period, YSI will
repair or replace, at its sole discretion, free of charge, any product that YSI determines
to be covered by this warranty.
To exercise this warranty, call your local YSI representative, or contact YSI customer
service in Yellow Springs, Ohio at +1 937 767-7241. Send the product and proof of
purchase, transportation prepaid, to the Authorized Service Center selected by YSI.
Repair or replacement will be made and the product returned, transportation prepaid.
Repaired or replaced products are warranted for the balance of the original warranty
period, or at least 90 days from date of repair or replacement. The end user making a
claim under any of these warranties is responsible for all product removal and reinstallation costs related to any product repair or replacement under any such warranty.

Limitation of Warranty
This warranty does not apply to any YSI product damage or failure caused by:
1. failure to install, operate or use the product in accordance with YSI’s written
instructions;
2. abuse or misuse of the product;
3. failure to maintain the product in accordance with YSI’s written instructions
or standard industry procedure;
4. any improper, incorrect or substandard repairs to the product not performed
by YSI;
5. use by anyone (other than YSI) of any defective or improper component or
part in servicing or repairing the product;
6. modification of the product in any way not expressly authorized by YSI.
THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. YSI’S LIABILITY UNDER THIS WARRANTY
IS LIMITED TO REPAIR OR REPLACEMENT OF THE PRODUCT, AND THIS
SHALL BE THE SOLE AND EXCLUSIVE REMEDY FOR ANY DEFECTIVE
PRODUCT COVERED BY THIS WARRANTY. IN NO EVENT SHALL YSI BE
LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL
DAMAGES RESULTING FROM OR CAUSED BY ANY DEFECTIVE PRODUCT
COVERED BY THIS WARRANTY.
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Contact Us

Recycling

Appendix 7 Contact Us

Appendix 8 Recycling

Ordering and Technical Support

Recycling

Please visit www.ysi.com for a list of YSI’s locations worldwide along with additional contact information.
YSI, Inc. Corporate Headquarters:
Telephone:

Fax:
Email:
Mail:

Web Site:

800 897 4151 (US)
+1 937 767 7241 (Globally)
Monday through Friday, 8:00 AM to 5:00 ET
+1 937 767 1058
environmental@ysi.com
YSI Incorporated
1725 Brannum Lane
Yellow Springs, OH 45387 USA
www.ysi.com

When placing an order please have the following available:
1.) YSI account number (if available)
2.) Name and phone number
3.) Purchase Order or Credit Card
4.) Model Number or brief description
5.) Billing and shipping addresses
6.) Quantity

Service Information

YSI is committed to reducing the environmental footprint in the course of doing
business. Even though materials reduction is the ultimate goal, we know there
must be a concerted effort to responsibly deal with materials after they’ve served
a long, productive life-cycle. YSI’s recycling program ensures that old equipment
is processed in an environmentally friendly way, reducing the amount of material
going to landfills.
-

Printed Circuit Boards are sent to facilities that process and reclaim as much
material for recycling as possible.
Plastics enter a material recycling process and are not incinerated or sent to
landfills.
Batteries are removed and sent to battery recyclers for dedicated metals.

When the time comes for you to recycle, follow the easy steps outlined at
www.ysi.com.

Battery Disposal
The circuit board in this instrument contains a manganese dioxide lithium “coin
cell” battery that must be in place for continuity of power to memory devices on
the board. This battery is not user serviceable or replaceable. When appropriate,
an authorized YSI service center will remove this battery and properly dispose of
it, per service and repair policies

YSI has authorized service centers throughout the United States and Internationally. For the nearest service center information, please visit www.ysi.com and click
‘Support’ or contact YSI Technical Support directly at +1 937-767-7241.
When returning a product for service, include the Product Return form with cleaning certification. The form must be completely filled out for a YSI Service Center
to accept the instrument for service. The form may be downloaded from www.ysi.
com by clicking on the ‘Support” tab, then the Product Return Form.
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5X00 family of instruments 8
5X00 systems 72
A

could not find unit error 65
device timed out error 64
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wiring 43
analog (non temperature) 45
digital 45

H
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Installation 24–44
Installation and wiring chapter 23
qualified installer 11
IOEM
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I (inputs) O (outputs) 71
mode 72
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Bulkhead fittings 30
rubber grommets 30
C
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Configuration chapter 69
Contact Us 94
Control board 33
E

E-Aux
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virtual system 72
expansion module firmware updater directions 60
F

Ferrite bead installation 35
Firmware Updater
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Hardware
bulkhead fittings 30
installation & wiring chapter 23
PCBs 28
I

L

Lightning and Surge Protection 65
Local machine 71
instrument and relay names at 5X00 instrument menus 71
M

Mode 72
mount IOEM and REM 26
N

Network
wiring
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stars 53
stub 49
Network termination relay 56
P

Panel mount 5200A 27
Parts and accessories 92
PCBs (printed circuit boards) 28
Power (wire) 35
AC 35
DC and backup 38
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W

R

Rail mount 5200A 26
Recycling 95
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wiring 40
REM
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Remote machine 71
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S

Safety
cautions 20
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relays 13
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Warranty 93
Weather shield 27
Wiring
4/20mA output 47
aux (auxiliary inputs)
temperature 46
aux (non temperature)
analog instrument 45
digital instrument 45
bulkhead fittings 30
communication equipment
rs232 59
control board 33
PCBs 28
power
AC 35
DC 38
backup 38
relays (outputs) 40
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